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Epyaotnplo Aoyikng Zxediaonc (K02e)

[MpoAoyoc

OL epyaotnplakéG AOKNOELG TOU padnuatog adopolv tn oxediacn PndLlakwv KUKAWUATWY Kal tTnv uAomoinon)
Toug oe texvohoyia Field Programmable Gate Arrays (FPGAs) pe tn xpnon twv KotdAnAwv epyaleiwv
AoylopikoU tng XILINX (Vivado Design Suite). Zuykekpiuéva adopouv tn oxedioon pe tn yAwooa neplypadng
UAWKoU VHDL, tn &nuoupyia kat@AAnAwv meploplopwy xpoviopou (timing constraints) kat 1/0 (I/O
constraints), tn ouvBeon (synthesis), uhomoinon (implementation) kat mapaywyr Tou bitstream otoxevovtag
OUYKEKPLUEVO FPGA kaBwg kat tnv emaAnBeuon tng opbng oxediaong (verification) oe oAa ta Sladoxikd
enineda oxediaong (mnyaiog kwdikag VHDL, post place & route netlist) pe mpooopoiwon (simulation), tnv
anoodpalpdtwon (debug) kabwg katl tnv emaAnBesuon tng Asttoupylkotntag oto UAKO (FPGA validation) pe
xpnon kataAnAng avarmtuélakng kaptag (development board).

Ta Pndlakd KukAwpata mou Ba ulomotnBouv Ba £xouv KALLOKOUEVN TIOAUTIAOKOTNTA Kal SL8aKTIK afla
TapOUOLa [E OVTIOTOLXA TTIOU SL8ACKOVTAL OTO TIPOTTUXLAKO PABnua koppou tng Aoyikng Zxedioong (K02) to
orolo Oswpeltal mpoamATOUEVO EVW UTIAPXEL CUVTOVIOUOC otnv St8akTéa UAN.

Ta FPGAs mou Ba xpnowuomnotnBolv wg target devices otnv ekmawdeutikn Sladikacia Ba elval auvtd mou
TAPEXEL N UTIOSON TOU €pyaoTtnpiou o avamrtuéloKeg KAPTEC. H o KatdAAnAn, olyxpovn avamtuélakn
Kapta mou mapéxetal amno tnv XILINX yia akadnpaikoug okomouc sival n ZedBoard.

TéNog Ba mpémnel va onpelwBel OTL 0 08Nyog Ba evnuepwvetal kab’ OAn tn Sldpkela Tou e€QUVoU WOTE va
EVOWMOTWVEL TIG Suvatotnteg Tou VIVADO Omwe autég mapouatdlovtal Katd Thv mpoodo Twy pabnudtwv. O

06nya¢ LoyLeL yia omota €kdoon tou VIVADO Kal Qv £XETE.




Elcaywyn oto EpyaAeio Vivado

Eloaywyn oto EpyaAeio

Y€ aUTN TNV ELCQYWYLKA Ttapouaiacn Ba dolpe avaluTtikd tn xprion Ttou gpyaleiou Vivado IDE tng Xilinx yia
TN dnuLoupyia evog amlol KUKAWUOTOG LE Xpron TnG. Oa douue Ta BApata TG MPOooopoiwaong, tTng cuvbeong
KoL TNG UAomoinong Tou oxedlou XpnoLOMOLWVTAS TG TipoKaBoplouEveg pubuioels. Ma Toug okomoug TG
napouciaong Bewpolpe otL pe tn xprion tou VIVADO Ba AUooupe tnv acknon (mou avaAUCOUUE Kol O€
OLoAEEELG) TTOU aKOAOUOBEL:

Epyooctdcto £xelL Seapevh enefepyaoiog uypwv. H dsfapevi mpénel ajva £xsl Osppokpacia petad 25 kot
30 BaBpwv Kat B) n oTaON TOU MPEMEL va €lval MAvw ano éva eninedo. I nepintwon nou 1o a) i to B) dev
LKOLVOTTOLOUVTOL TIPETEL VA evepyomotnBel éva koudoUvl. Napadoxég: afExoups Beppopetpa otn diabeon
JLOLG TTOU UITOPOUV VAL [LOLG EVIILEPWOOUV EAGV N Beplokpaocia eival mavw ano éva 6plo (6molo 6pLo BéAoue)

Kol B)YnapxeL aloOntrpog mou Hog EVAEPWVEL EAV N oTABUN otn Se€apevN) elval KATw oo éva eninedo.

216)O0I

Me tn pelétn tou purradiou Ba elote og B€on va:

e Anuwoupyeite €va project oto Vivado, va opilete ta apyeia HDL mou meplypddouv To HOVIEAO TOU
KUKAWHOTOC Kol va opilete w¢ target, To ZYNQ FPGA mou ¢ofeveital otnv avamtuélakn kapta
ZedBoard.

e [lpocopolwvete To 0XESLO He Tov simulator Tou Vivado

e Kdvete oUvBeon (synthesis)

Fevikn pon oxediaong yia TTARpn avarmTugn

BAua 1: BApa 2 BApa 3 BAua 4
Anpioupyia evog RTL Analysis — Mpooopoiwaon Tou T0vBeon Tou
Vivado Project Anpioupyia Tou 2xediou Wneiakou Txediou Wneiakol
XPNOIPOTTOIWVTOG Sxediou Wnepiakou KukAwparog pe 10 KukAwpaTog
10 IDE KukAwpatog Vivado Simulator




Epyaotnplo Aoyikng Zxediaonc (K02e)

Anuwovpyia evog Vivado Project pe to IDE BAiua 1

1-1. Avoiéte to Vivado kat dnpioupyeiote Eva project £xovrag wg target to device XC7Z020clg484-
1 kat xpnoonowwvrag tnv VHDL. XpnoLLOTIOLROTE TOV YO0 KWELKOL TTOU  GOLG TLOLPEXETOLL
labl.vhd. Avaloya pe thv £€kdoon tou Vivado Kat Tig EMAOYEG EYKATAOTOONG LOWG UTTAPXOUV
SLadopEg oTig EMAOYEG TWV HEVOU.

1-1-1. Avoi&te 10 Vivado smiAéyovtag Start > All Programs > Xilinx Design Tools > Vivado 2019.2 > Vivado
2019.2. e mepimTwon TOU UTIAPXEL TO avTiotowo elkovidlo oto Desktop amAd kdvete SUMAG KALK
(mpoooyn OXI oto Vivado HLS 2019.2)

1-1-2. Notrote Create New Project (A File-> Project->New) yLa va Eekivrioete tov wizard. Qo Seite évol kKouti
Slohoyou Create A New Vivado Project. Natnote Next. Ie mepimtwon mou To project €xel nén
SnuoupynBel pmopou e va To eTiAEEoUE e TO Project_name eite amo to Open Project oto mapdBupo
Quick Start, eite and to mapdbupo Recent Project.

1-1-3. Natrote To kouuni Browse tou nediou Project location tng ¢popuag New Project, kot kdvete browse
oto ¢padkeho mou Ba tormoBetrioete To project cag (oto mapddeyud pag d:/Logic) kat tatrjote Select.

1-1-4. rpayrte vivado_intro oto nedio Project name. BeBawwBeite otL To Kouti Create Project Subdirectory box
elval emheypévo. Napotnpnote OTL OTNV EMOUEVN ypauun daiveral o katdAoyog otov omoio Ba
SnuoupynBei to project. Matrjote Next.

S D =

Project Name

Enter a name for your project and specify a directory where the project data files will be stored. ’
Projectname: |vivado_intro |
Project location: |D:/Logic E‘
+| Create project subdirectory
Project will be created at: D:/Logichvivado_intro

(2)

Ewova 1. Eloaywyn Project Name kau Project Location




Elcaywyn oto EpyaAeio Vivado

1-1-5. Kavte kAwk otnv ermthoyn RTL Project otnv endpevn 08ovn (dodpua Project Type), kat etheé€te Next.
Eniong mapatnpeiote OTL £xoupe KAVEL KALK otny emloyr Do not specify sources at this time. Auto
onuaivel 0tL dev £xoupe apyeia e £TOLLO KWSLKA YLOL TO project Kot OTL Ba SnULoUpYr|CoUE Ta
avtiotolya apyela péoa amd to MPOypaa. € TEPUTTWON TIOU £XOULE £TOLUA TTapOpoLa apxeia AEN
B PEMEL VAL KAVOULLE KALK.

e . -
Fraject Type
Spacity tha type of praject ta craste ']

® BILPojed
‘You will be able 1o add sources, create bock cesigns in IP Integrator, generate IP. run RTL analysis, syninesis,
HApEmEntalon, Gesagn plEanning and s

| Qo not specify sources at fis sme

Poslsymihesis Project
You will be able 1o add sources. view device rescurces, fun design analysis. planning and impsementation.

1 Pianning Project
Do not specify design sources. You will be able o Wew panipackage résources,

Emported Project
Create a Vivate project from a Synpity, X5T or ISE Project File.

Exampie Progect
Create a nw Vivarda project froem i predefined template

z [ o> | [_canens|

Ewkova 2. Emidoyn RTL_Project

1.1.6. Ztn dopua Default Part , xpnowuomnotnote tnv emloyn Boards kat to drop-down pevou tou ¢idtpou
Vendor smniléyete To em.avnet.com. ['a tnv ZedBoard, emiAé€te To part XC72020clg484-1 (Bavotata
Ba eival kat n povadikn oag emhoyn). Napatnpriote Tig TANPodopIeg TTOU UTIAPXOUV Lo TNV K&pTOL
Tou emAE€ate OwG N katnyopia (Zyng-7020) otnv omola avrkel 0Tl €xeL 484 akpoSEKTEG Kal TaUTNTA
(speed grade) -1 (To mLo apyo NG olkoyEveLlac) KaBwc kol ta StabEaiua resources Tou eTAeYUEVOU part
(IOB =200, LUT Elements = 53.200, Flip-Flops = 106.400, Block RAMs = 140 kot DSPs = 220)

T =
Default Part
Choose a default Xilinx part or board for your project. ’

Parts | Boards

Reset All Filters Update Board Repositories

Search: Q- v

Display Name Preview Vendor File Version  Part

ZedBoard Zyng Evaluation and Development Kit

Add Daughter Card Connections em.avnetcom 14 XcTz020clg484-1

< >
(2) =

Ewkova 3. EmAoyr] TnG avamntu§LoKiG KAPToG

! EvaMaxtika Xpnoluorotote tnv erhoyr] Parts kat ta Stadopa nedia drop-down tng emdoyng Filter. Na tnv ZedBoard,
eTUAEETe TO part XC7Z2020clg484-1.




Epyaotnplo Aoyikng Zxedlaong (K02e)

1-1-10.EmAé€te Next.

1-1-11.3to mapaBupo Stahoyou New Project Summary BAEémete 1o project_name Kal Ta
XQPOKTNPLOTIKA TNG eTAeyUéEVNG (default) Siataéng FPGA.

A e Fregect 3

Mivw Project Susimary
B & mew HIL project named TSG LAE 7 will ba cremiwd

@ The defaidt pan an | proadha Faamily S0 T resa pogec

Dorbaa it Bl DisaBoaad D Exabiatos gad Dl opva K
Dkt Parl: we 7 E 0 gl 8-
Preddacl Hmg- V300

Farmty: Smg- 2000
Pachoage: chpild
St e

£ XILINX. o et proect ek vy

)

1-1-12.Matrote Finish yla va dnuwoupynoete to Vivado project. Napatnpnote 1o neptBaiAov Tou
PROJECT MANAGER mavw oto omoio Ba oxedidocoupe to Pndplokd KUKAWHOTA HOG.
Avayvwpiloupe tnv opllovtia pmapa emavw Pe emhoyeg File, Edit, Flow, Tools, Reports,
Window, Layout, View kat Help. To katakopudo napabupo aplotepd tou Flow Navigator,
OToU e KATAAANAn emhoyn ektedouvtal ola ta BApata tne Pndlaknc oxediaong. To
napabupo Sources, 6mou ¢aivovtal OAa ta mnyaia apxeia tou project Stapbpwuéva ota
directories: Design Sources, Constraints, Simulation Sources kat Utility Sources (apxtka sivot
adelo). To mapabupo Properties. To mapdBupo Project Summary (oe kaBe PBApa g
Pnoraknig oxediaong Stadopomnoteital katdAAnAa). TEAog, To KATw opl{oviio mapdbupo
TIOAA QA WV XPrOEWV, TTOU XpNOoLUEVEL PeTaEL AAAwVY wg Tcl Console kat yla tnv avadAluon Twv
AMOTEAECUATWY TNG oLUVOEDONG KAl TNG UAOTtoLnONG.

vt 365 (e ot ool g - Vi 33 o T

e Ragm  fwdew e b ] =

Promct Semmary

e W Mesage

Ewova 4. Baowkny 006vn evog Project oto Vivado
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Elcaywyn oto EpyaAeio Vivado

1-2.

1-2-1.

1-2-2.

1-2-3.

Anpovupyia apxeiov Kwdwka buzzer.vhd

210 mapdBupo Sources, kavte Sei-click otnv emloyr) Design Sources Kal KATOTLV KAVETE KALK OTNV
emhoyn Add Sources. 2to napaBupo Add Sources mou sudaviletal eniléyete 1o Add or creare design

sources. Natdrte to Next. 2to enopevo mapaBupo Add or Create Design Sources erthéyete to Create File.
4 Add Sources P

Add or Create Design Sources
Specify HDL, netlist, Block Design, and IP files, or directories containing those file types to add to your project. Create a new source file on '
disk and add it to your project.
+, p 9
¢ Create Source File X
Create a new source file and add it to your
project. [
File type ® vHDL w
File name: |buz_er| |
Filg location: e =Local to Project= hd
=
{e U
\
(=)

Ewova 5. Anpoupyia apxeiov VHDL ovtotntog/ apXLTEKTOVLKAG

210 mapabupo Create Source File ermléyetal wg File Type to VHDL, kol TANKTPOAOYELTE TO OVOLA TOU
opxeiou mou Ba MepLEXEL TOV KWK TOU TIPOYPAUUATOC Hag (oTnv Mepimtwor) pag to buzzer). Me autég
TIC EMAOYEC 0aG EXETE SNAWOEL OTL N YAWOOO MPOYPAUUATIOMOU TIou Ba xpnolpomnotoste Ba gival n
VHDL, kat dpa n katdAnén tou apxeiou mou Ba dnpoupynOei Oa eival.vhd. Ondte natwvrag to OK €xete
dnuoupynoel to apyeio buzzer.vhd. Yotepa emiléyete To Finish.

210 napaBupo Define Module, mapatnprote otL 1o Vivado €xeL kAvel U0 POETIAOYEG. ZaG POTELVEL
a)va ovopdoete buzzer tnv oviotnta (Entity name) tou kukAwpatog ou Ba oxedldoete (omwg SnAadn
TO Ovopa Tou apxeiou mou Ba mepléxel tov kwdika tng VHDL) kat B) va ovopdoete Behavioral tnv
OPXLTEKTOVLKNA TNG ovtoTnTag. Edv BéAete punopeite va aAAAEETE Ta ovopaTa, CUUPWVA LIE TOUC KAVOVEG
Tou Loxuouv otnv VHDL, yla To mapddelypd pag opwes ormAd atdre To OK Kal oTto enmopevo mapabupo
natare to YES.

MAfov mopatnpeite OtL oto mapabupo Sources Kal KATwW omo tnv emidoyr) Design Sources €xel
dnuoupynBel n ovtotnta buzzer, e TNV apXLTEKTOVIKA behavioral, oto apyeio buzzer.vhd. Kavte SumAd
KALK oto ypaupn buzzer kat Ba avoifel éva mapdBupo mou Ba £xel Tto apyeio buzzer.vhd pe
TIPOCUUIMANPWHEVO KATIOWO Baotkd kwdka (Baotkég BLBALOBNKeC, Kal Baoikol oplopol TNG ovtoTNTAG
KOLL TNG OPXLTEKTOVIKNG TNC). MAEOV UMOpPEITE VA CUUTTANPWOETE POVOL 0AG KWALKA. ITNV EPIMTWON 00¢
umnopeite va ypaete tov kwdika mou eival oto eclass, ota £yypada kal va avadEpete oTo 2° padnpua.




Epyaotnplo Ao

ogefiercond.

VK¢ 2xeblaong (K02¢)

fimrion? seample apr - Vo 20157

berter.vnd
-] DA spichansnar_seamelalaniand_sxampls SICaimauress_Unawituazes vhd

a L2 B B X N EQ -}

Ewkova 6. Epdavion neplexopévou evog apyeiov VHDL
1-3. Anovupyia apxeiov kKwdka npooopoiwong buzzer_tb.vhd

H énuoupyia tou apxeiou mpocopoiwaong akoAouBel Tnv avaioyn Sladikoaoia pe auTr Tou akoAouBnoaype yLo
™ Snuioupyla tou apyeiouv buzzer.vhd (entity/architecture), nAaén tnv napdypado 1.2.

1-3-1. AxoAouBoUpe ta Brpata tng mapaypddou 1.2.1 O dtadopég lval:
210 mapabupo Sources emiAéyoupe Simulation kau oto mapaBbupo Add Sources mou gudavileTol
emuAéyete To Add or create simulation sources. Motdte to Next. Zto enopevo napdBbupo Add or Create
Simulation Sources sn\éyete to Create File. ¥to mapdBupo Create Source File mAnktpohoyeite to dvoua
TOU apxeiou ou Ba MEPLEXEL TOV KWEIKA TNC TIPOCOHOIWONE TOU TIPOYPAMUOTOC Hag (oTtnv meplmtwon)
pog to buzzer_tb). Mia yeviki apxi mou akoAouBoUpe eival OTL TO apxeio TNG mpoocopoiwong €XeL To
Ovoa ToU apyeiou TG ovtotnTag Ke TNV poodrkn oto téAog tou _tb.

1-3-2. AkoAouBoUpe ta Brpata tng mapaypddou 1.2.2.

1-3-3. AkolouBoupe ta BrApata g mapaypadou 1.2.3. MALov mapatnpeite 6tL oto mapdBbupo Sources Kal
KAtw amod tnv enthoyn Simulation Sources -> sim_1 €xelL dnuioupynBel n ovtotnta buzzer tb, pe tnv
QpXLTEKTOVIKN behavioral, oto apxeio buzzer_tb.vhd. MAEov UMOPEITE VA CUUMANPWOETE LOVOL OOC
KwdLKa. TNV Mepimtwor oag unopeite va ypaete tov KwdLka ou eival oto eclass, ota éyypada Kat
va avadEpPETe oTo 2° padnua.

1-4. EVEpyELEG O MEPLMTWON TTOU EXOUE REN SNLOVPYNAOEL TA APXELCL TOU MPOYPAHATOC KoL
0€éAoupe va ta mpooBécoupe Kata tn Snpovpyia tou project.

1-4-1. 3to BApa 1.1.5 AEN kdvoupe KAk otnv ertthoyry Do not specify sources at this time. Autd onuaivel ot
€Xoupe apyelo pe €tolo KWK yLa To project.

1-4-2. Xpnolpomolwwvtog Ta Koupmid drop-down, emidé€te VHDL wg Target Language kol Simulator
Language otnv dopua Add Sources.




Elcaywyn oto EpyaAeio Vivado

-
¢ New Project M
Add Sources
Spedify HDL and netiist files, or directories containing HDL and netlist files, to add to your project. Create a new source file on disk ‘

and add it to your project. You can also add and create sources later.

= | &

Add Files Add Directories [ Cresterie |

Ta'getlanguage:'\'HDL - Smjatorlarq;age

L2 ] (oo [ Nedt> ]| - (L_conce

Ewkova 7. Emloyn g VHDL wg Target kou Simulator language

1-4-3. Natnorte ite ajto MNpaotvo Kovprni + (mavw kat g€a), kat peta Add Files eite B) Add files (katw kat
OTO KEVTPO) Kal eTUAEETE TO apXElo e TOV KWBELKA TNG OVIOTNTOG/ APXITEKTOVIKNAG (OTNnV meptttwor pog) buzzer.vhd.
Mortdree To OK. AkohoUBw(g emavaAapBAvete th Sladikaoion Kot TPOCHETETE Kall To apxelo The mpooopoiwong (otnv
nepirtwor) pog to buzzer_tb.vhd). Edv Sev eival nén emileypuévo, emhé€te Copy sources into project. TENOG
natrjote 1o OK. Metamatrote Next yla va dte otn ¢opua Add Constraints, otnv omoia arAd rotdte to Next.

MA€ov ouveyiletal amno to Brua 1.1.10




Epyaotnplo Aoyikng Zxediaonc (K02e)

1-5.

1-5-1.

1-5-2.

1-5-3.

Apxeia kwdika VHDL

Xpnowonowjote to Windows Explorer kat kottd€te oto ¢dkedo mou opioate to project (my
d:\Logic\vivado_intro). o Bpeite otL £xel SnuioupynOel, petafl AAAwv Ka, o dpakeAog vivado_intro.srcs
Kol to apyelo vivado_intro.xpr (apxeio Vivado: pe SmAS KAk Ba avoiel péoa oto Vivado). Avo dakelot
sim_1 katsources_1, €xouv dnuiloupynBel péoa otov dpakeAo vivado_intro.srcs mou MepPLEXOUV TA apXELT
buzzer_tb.vhd kat buzzer.vhd avtictoiya.

%v‘ » Computer » D(D:) » Logic » vivado_intro »

File Edit View Tools Help

Organize « Include in library « Share with = Burn Mew folder
-
Lessons i Name Date modified Type Size
4 | Logic . . i .
. vivado_intro.cache 18/11/2020 8:03 pp  File folder
. Lab1 . . i
vivado_intro.hw 18 File folder
Lab_11 . . 3 )
. vivade_intro.ip_user_files 18 File folder
. Lab_11a . . = .
. vivado_intro.sim 18, File folder
> . Lect d4_parta . . )
vivado_intro.sres 18 File folder
Lect_4_parth . . . .
¢ vivado_introxpr 18 Vivade Project File 9 KB
. Lect 4 _partc
. Lect 5_parta
» | Lect_5_parth
. Lect 5 _partc

lecture_4_test
. lesson2_example
> | lesson3_example
project_1
. project_2

m

> | project 3
star_project0l
J testl
= | vivado_intro

E Logic Design_Lab

Ewkova 8. Ermtidoyr) tng VHDL wg Target kou Simulator language

Mmopeite kaBe otyun va petapeite oto mapabupo Sources péow Tou pevol Windows->Sources.

Mropeite va mpooBoste £va vEo apyeio oto project mépav 6owv avadEpbnkav otig mapaypadoug 1.2
kot 1.3 kot amo 1o mapabupo Flow Manager->Project Manager->Add Sources, onote kat odnyeiote
otnv akoAouBn 0Bdvn omou enhéyetal To €60¢ Tou apxeiou Tou BEAeTE.

4 Add Sources b —— &J
’ Add Sources
V|Vﬁ9wo This guides you through the process of adding and creating sources for your project
Add or create constraints
Add or create design sources
®) Add or create simulation sources
-
£ XILINX
P

Ewova 8. Eloaywyr apxeiov VHDL oto VIVADO
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Elcaywyn oto EpyaAeio Vivado

RTL AvaAuon BAuna 2

2-1. EktéAeon avaluong RTL otov mnyaio kwdka.

2-1-1. >tomapdBupo Flow_Navigator/PROJECT MANAGER umdapyxel n emihoyr) RTL_ANALYSIS. Enekteivete 1o
Open Elaborated Design tou RTL Analysis task kol kavete kKAik oto Schematic.

To povtélo tou oxediou Ba yivel elaborate kat pia mapouciaon tou oxediou pe Aoylkég TUAeC Ba
eudaviotel oto mapdBupo schematic. (Matdpe OK av xpeaotel). BAEémeTe oxnUATIKA TO KUKAWO TTOU
LooSuvapEl Pe TO KUKAWUA TIOU €XETE TtePLlyPAEL OTO APXELO TNC OVTOTNTOC/ OPXLTEKTOVIKNAG
(buzzer.vhd).

Project Summary x| Schematic  x buzzervhd x 200

@ 6 N m ¢ C  2Cels 4l0Ports 5 MNets o

10
low_level >
]

buzzerd_i RTL_CR

buzzer

above_30

above_ 25
RTL_OR

Ewova 9. To oXNHATIKO SLdypajLpa Tou oxediou
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Epyaotnplo Aoyikng Zxediaonc (K02e)

Npocopoiwon tou Zxediov pe tov Vivado Simulator BAiuna 3

AoBEvTog OTL €xeTe SnULoUpYNOEL N pooBEael Tov Kwdika VHDL yla tnv mpooopoiwaon amno to Bipa 1,
TiPOXWPALE 0T Xprion tou Vivado Simulator.

3-1. Npocopoiwon tou YndLakol KUKAwHATOG Xpnotponolwvtag to Vivado simulator.

3-1-1. EmuAé€te and to pevou Flow Navigator-> Settings-> Simulation Settings (1} ané to mAaiolo Flow
Navigator-> Project Manager->Settings) tasks tou napaBupou Flow Navigator.

Kdtw amo to Project Settings -> Simulation

3-1-2. EmAé€te Tnv koptéla (tab) Simulation, 8£ote to Simulation Run Time (xsim.simulate.runtime) ota
160ns. MNapatnpeiote OTL 0TO KATW MAALCLO Tou MapaBUpou UTIAPXEL €MeEnynon yla TN ohacio TNG
TLUNG TTIOU SWOAE OTN  CUYKEKPLUEVN pUBLLON Tou project. O xpovog tou simulation e€aptatal ano
Tov avtiotowo kwdka. MNatnote Apply + OK.

i

Prejact Settngs
General

Ewkova 10. OpLopdg tng StdpkeLag tne npocopoiwong (simulation run time)

3-1-3. Matnote oto Flow Navigator -> Simulation-> Run Simulation > Run Behavioral Simulation.

To testbench kat ta apxeia Tou nnyaiou kwdika Ba yivouv compiled kat Ba tpé€et To Vivado simulator
(edpooov BEPata Sev umtdpyxouv obdaApata). Oa deite Tnv £€060 Tou simulator ou sival mapopolo pe
™V mapakdtw (elote mAfov oe meplBarhov simulation).

12



Elcaywyn oto EpyaAeio Vivado

SIMULATION - Behaa0rsl Simulahon - FUncional - £1m_1 - buzzer_ih

Scopo Dbjocts t L Ustied 2
Q = & 4 Q G | W a a ;3 « 1M o o

Name Design U Block Type

TelConscdn

Ewkova 11.E€o60¢ tou Simulator

Oa beite T€ooepa KUpla mapaBupa: (i) Scope, 6mou mapouaolaletal n tepapyia tou testbench kabwg
KoL To instantiations (m.x. Tng ovrotntog mou BéAoupe va mpooopolwooupe), (ii) Objects, omou
eudavidovtal ta top-level onuata tng Lepapyioc. Elval Ta eowTEPIKA oApaTa TNG OVIOTNTOC
npooopoiwong buzzer tb, mou avrtiotooUv OTIC €l0060UG Kal €£O60UC TNG OVTOTNTOC TOU
T(POCOOLWVOULE. Mpocoxr OTL €AV UTIAPXOUV Kol EMILMAEOV ECWTEPLKA onuata Ba eudaviotolv Kot
autad, (iii) To mapdbupo pe TIC KUUOTOUOPDEC OTIOU BAEMOU LE TN LETAROAN TWV TILWV TWV CNUATWY,
kat (iv) Tcl Console (katw amod tnv Kupotopopdn), Omou eudavilovial oL EVEPYELEG TIOU EyLvav
KOTd to simulation (mapatnprote 0tL uTtapXouV Kal dAAa tab: Messages kat Log).

Mavw and to moapabupo pe TIg KupatopopdEg, Ba Seite Sladopa elkovidSLa/KOUUTLA TTOU UIToPOUV
va XpnoLponotnBouv yla CUYKEKPLUEVO OKOTIO. Av adrosTe To S€IKTN TOU MOVTLKIOU TTAVW amo KAbe
ewkovidlo Ba epdaviotei n

3-1-4. Matrote to Koupni Zoom Fit « ) yla va eite 6An tnv kupatopopdr. MNapatnprote otL n £€060o¢
petaBdaletal otav petafarletal n elcodog. Mmnopeite emiong va avolfete TIg KupatopopdEg oe €va
VEO Heydlo mapdBupo matwvtag To Koupni Float mou Ppioketal oto mavw Sefld pépog. MNa va
enavadépete to floating mapaBupo, anAd natrote oto koupni Dock Window.

110 =
9115.-"‘

Ewova 12. Kouprni Float

_ @ el X

I -

Ewkova 13. Koupni Dock Window
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Epyaotnplo Aoyikng Zxediaonc (K02e)

3-3. NpocBéote mepLocotepa oHUATA YLo VO TTOAPOAKOAOUONOETE Ta oHUOTA XOUNAGTEPOU
ETUMESOU KAl YLOL VOL GUVEXLOETE TNV Tpooopoiwon yia aAla 200 ns.

3-3-1. 1o mapdBupo Scopes kavte KAK oto buzzer_tb. Napatnpnote otL epdaviletal oto nmapabupo Objects
Kol TO eowteplkd onuo dummy std logic_vector mou eival SnAwpévo oTnV oOvVTOTATA TNG
npocopoiwonc.

SIMULATION - Behavioral Simulation - Functional - sim_1 - buzzer_tb

Scope  x Sources — 0O @G Objects »* ProtocolInstances | ? _ O 4
o T s & |o o
Mame Design U... Block Type ~ Mame Value Data Ti ™
v 3 buzzer_tb buzzer_tb(B: VHDL Entity 14 above_30_tb 0 Logic
& uut buzzer_entitt VHDL Entity 14 above_25_tb 0 Logic
12 low_level_tb y Logic
12 buzzer_tb 1 Logic
» B dummy_std_lngic_ve:i 3 Array

Ewkova 14. Emtiloy onpatwv XopunAdtepou smunédou

3-3-2. En\é€te to onua dummy_std_logic_vector kat kavte drag oto moapdBupo UE T KUMOTOUOPGDES
yla va to TapakoAouBroste. EvaAlaktika kavete Se€i kAk ->Add to wave window.

3-3-3. Zto ribbon bar tou mapaBlpou e ta epyaleia TG Mpocopoiwong mAnktpoAoyrote 200 oto nedio
simulation run time, natnote click oto drop-down kouprni tou mediou e TIG LOVASEG Kal ETUAEETE ns
(Wit mole~ w2zl @) epOOOV BEAOUUE VO TPEEEL N Tpooopoiwan yia dAAa 200 ns (cuvoAika 360ns)
Kal matote to koupri ( ) button. H mpooopoiwon Ba tpg€et yia srurhéov 200 ns.

3-3-4. Matnote oto Kouuni Zoom Fit kol mapatnpeiote tnv €€060.
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Elcaywyn oto EpyaAeio Vivado

SIMULATION - Bishaorsl Simulasen - Functional - sim_1 - buzzer_fs

Stope Objects Untitied &
a = = o Q 4 |a W a @ ;o< MM o= ox A o

Mame DesignU.. Deock Type | Mame Valug
B buzzer tb b

W uut

1
o
o
o

Ewkova 15. EKtéAeon npocopoiwong ya emunAéov 200 ns

Mropeite va mapatnproste to mapdbupo Tcl Console yla va deite To pvupa mou epdavilel.

3-4. AMN\a€te to format tng mapouvoiaong v To emBupEeite

Mapatnprote OTL oTNV utdpxouca Kupatopopdn Sev daivovtal oL TIHES Twv onuatwy std_logic kabwg
T(POKUTITOUV Ao TNV Kupatopopdn, avtiBeta pe to onua dummy_std_logic_vector. AimAa oto 6vopa
KABE ONOTOG UTTAPXEL N TLUI TOU O€ KABE Se80UEVN XPOVLKI OTLYUNA TNG TPooopolwang. Kavovtag KALK
oe Sladopa onpeia péoa otnv Kupotopopdn mapatnpoUue OTL AAAA{OUV KOl OL TIHEG TWV CNUATWY
otn otnAn Value.

Natwvtag 6g€l click og kdmowo onua (otnv nepintwor pog pévo oto dummy_std_logic_vector),
eTUAEETE Radix, kol otn ouvéxela emNé€te Binary ylwo vo BAEmete TI¢ €l06doug oto Suadilkd N
Hexadecimal yia to 8ske€adikod (umdpxouv emloyEg yla signed/unsigned avamapaoctdostc, KAm).
Mropelte va emidé€ete éva povo onua 1 MoAAQ onpoata podl Kot va KAVete tnv aAlayn tng
avarnapdotacng. Mpocoyn MAavta otnv MEPIMTwon mou To onpa eival tumou std_logic, ylati tote n
emthoyn Radix Sev eival StaBéaun.

3-5. OAokAnpwon dwadkaciag simulation

KAeiote tov simulator emiAéyovtag File > Close Simulation. Natrjote OK Ko 0TV CUVEXELA TIATNOTE
Discard yta va KAgloel YwpLG VoL GWOETE TNV KUPOTOUOP®).
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Epyaotnplo Aoyikng Zxediaonc (K02e)

20vOeon tou Xxebiov BAua 4

4-1. Kavte cOvBeon oto ox£dLo pe to epyaleio cuvOeong tou Vivado kat avaAuote tnv £€§060
Project Summary

4-1-1. Natote oto Run Synthesis mou Bpioketal ota Synthesis tasks tou mapaBupou Flow Navigator. Av
UTIAPEEL EpWTNUA OXETIKO Ue “Launch runs on local host” matdape OK. (to (6lo av Eavampokuel To blo
epwtnua). AtmAa and o Number of jobs pmopeite va emhé€ete 1o mdoa threads Ba xpnotpononbouv
yla TNV eKTEAEON TNG epyaociag (Katd péyloto 8). EMAEETe avahoya e TOV EMEEEPYAOTH TOU UTTOAOYLOTH
0aQg.

H Stadikaoia tng ouvBeong Ba ekteleotel oto apyeio buzzer.vhd (kal og 6Aa ta apyeia tng Lepapxiog
Tou edpooov umapyxouv, dSnAadn ta component TOU (OWG UTIAPXOUV OTNV aPXLTEKTOVLKA). Otav n
Stadikaoia oAokAnpwBel (n Sldpkelo TOKIAEL avdAoya HE TV LOXU TOU UTtoAoyloth oag), Ba
gudaviotel éva kouti dtaldyou Synthesis Successfully Completed dialog box e Tpelg emAOYEC.

Synthesis Completed 2

o Synthesis successfully completed.

Hext

Eun Implementation
®) Open Synthesized Design
View Reports

Don't show this dialog again

Ewkova 16. OAokARpwon tng Z0vOeong

4-1-2. Emulegte tnv emthoyn Open Synthesized Design kol matrjiote OK edpooov emiBupolpe va Solpe tnv
££060 NG oLVBEONC TIPLV TPOXWPNCOUUE OTO 0TAdL0 TNG UAomoinang (implementation).

Matnote Yes yla va kAeioete 1o elaborated design av epdaviotel 1o mapdbupo Stahdyou.

4-1-3. Emulé€te Tnv koptéha Project Summary kot peletnote ta Siadopa napdbupa.

Eav 6ev BAEnete Tnv KaptéAa Project Summary tote emléCte Layout > Default Layout, i matriote oto €lkovidlo

2

Project Summary .
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Elcaywyn oto EpyaAeio Vivado

Project Summary
Ovenvséw | Dashboard

Progect nam: wivade_into

Progect locatin
Preduct tamily
Froged pant

Top module name:

Device, Project name, Top
module name

Targst language:
Simulator language

Board Part

Display name. ZedBoard Zyng Evaluation and Development Kit ’ I3

Rttt | G mi NAnpodopieg kaptog

Board revision e

Conneciors: NO Connechons FPGA

Reposilory path D Nivado! 2019 2databoardsboard_fles

URL hitp Mvweww cedboard org

Board overaew. ZedBoard Iyng Evaluation and Development Kt

S OOkt e i H vAomoinon &gv €xeL
Status o Complote oK npwcn ouv Ecnq St EEK[\I{\GEL
Messages 1 warming Messages

Fat Pan

Strategy Sratogy

Rapoa Strategy Réport Stategy T Raf

Incremental syrihesis Incremental imgptementation:
DRC Viclations Tirming
Utizaton postsmmesis | ponenesion  power | Utilization o€ ypoapikd

Gragh | Tasie nivako

Ewkova 17. Project Summary ywa ta anoteAécpata thg cUvOeong

Matnote ota diadopa links yla va deite TL mMAnpodopia mapéxouv Kat moLa ETUTPEMOUY va AAAGEETE
TIG puBpioelg Tng ouvBeoNC.

4-1-4. Natnote otnv kaptéla Table mou Bpioketal otnv kaptéla Project Summary. (H kaptéha Table sival
oto napabupo Project Summary, tab Overview, kdtw PEpog 0Bovng, meploxn Utilization, tab Table).

Mapatnprote OTL KAt ekTipnon £xeL xpnotpornotnBel 1 LUT ka4 10s (3 eioodol kat 1 £€060¢).

Utilization Post-Synthesis | Post-Implementation
Graph | Table

Resource Estimation Available Utilization %
LUT 1 53200 0.01
10 4 200 2.00

Ewkova 18. EKtipnon xpriong nopwv yia to FPGA tou ZedBoard

4-1-5. 3to Flow Navigator, péca oto Synthesis (emektelvete to Open Synthesized Design edv eival
amnapaitnto), natnote to Schematic yla va deite to Synthesized desigh og oxnuatikny avanapdotoon.
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Epyaotnplo Aoyikng Zxediaonc (K02e)

Schematic

low_lovol_IBUF_inst buzzie OBUF 2 i1

Ewova 19. Ixnuatikn avanapdotoon tou synthesized design

Mapatnpeiote OtL €xouv autopata mpootebel IBUFs kat OBUFs primitives oto oxédlo adol ol
eloobol kaL ot €€odol amo to FPGA eival buffered. OLAoyikég TUAeg €xouv uAomoinBet og LUTs (LUT3).
O 800 Aoyikég MUAEG TG avaAuong RTL €xouv yivel mapped og éva LUT otnv clvBeon.

Xpnowonowwvtag tov Windows Explorer, emoAnBevote Ot €xel dnuoupynBel o dakelog
vivado_intro.srcs péoa otov ¢dkeAo vivado_intro. Méoa otov ¢adkelo runs, €xeL dSnuioupynBei o
dakelog synth_1 mou nepiéxet Stadopa apxeia OXETIKA Ue TNV oUVOeON.

4-2. Xpoviki} avaAucon ToU KUKAWHATOG Kot T ZUvOeon

4-2-1. AobBévtog otL €xel yivel pwta To Ao 4.1.2, eEMIAEYOUE ATIO TN VPO TOU LEVOU TIC eETUAOYEC Reports-
>Timing->Report Timing. Epdaviletal n akoAoudn oBovn:

4 Report Timing e
Genesali a timing report
¢
Rusults name fiming_1 |
Targets
Start Points
From
Through Points
Thyaugh +
End Polnts
In
Commant: repor_rming -cilay_type min_mi -ma_paihs 10 -501_by group -npul_pins -tautibie_nols -mime ming_1
| Open in a new 1a}
| CIpien an Timing Analyses kot

Ewkova 20. Report Timing
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Elcaywyn oto EpyaAeio Vivado

Av BéAete pumopeite va Swoete £éva ovopa oto Report kat matdte oto OK. ITo KATw HEPOS TNG 086vNg
gudaviletal to report.

Rport Timing - fming_1

Ewova 21. Ot mAnpodopieg Tou Report Timing

210 KATW MEPOG daiveTal To Ovoua Tou report (timing_1), evw aploTepd Kal KATw oo Thv enloyn

Timing Checks, undpxouv 800 emiloyéc. Me tnv emiloyr Setup eudavilovtal To HLOVOTIATIO TOU

KUKAWMOTOC TIou €xoUE PTIAEEL pe TNV peyaAltepn kaBuotépnon. To povordrtt (Kpiotuo povomnart)

Me tnv peyalltepn kabBuotépnon (kabuotépnon Stadoong) sival auto mou gudaviletal Kal mpwWTo

(otnv mepimtwon pag to povomartt ival povo €va, to Path 2). Itn ypapun dtmAa amnoé to 6vopa tou

povornatiov epdavidovrtal kat GAAEG TANPOdOPIES, EVOEIKTIKA:

e Levels: Ta Pndlaka otoyeia mov neptAapPAveL TO pOVOTTATL

e From—To: Ta oTtolyela apxng KaL TEAOUG TOU povomatiol

e Total Delay: H kaBuotépnon &uadoong, Omou o xpovog tou Loigc Delay sival o ypovog
kaBuotépnong ota Pnolaka otolyeia kot Net Delay o xpdvog Siddoong ota cUppaTa TOU
ouvdéouv Ta PndLakd oTolyeia.

Avtiotolya pe tnv gmhoyn Hold sudavilovral to povomatio (oUvtopn SLadpopn) e T UIKPOTEPN

kaBuotépnon (kabuotépnon poAuvong) kal spdavilovral ol avtiotolyeg mAnpodopieg.

Eav B€éAloupe va doUpe OMTIKA To povomadrtt (r.x. To Path 2) kGvoupue mpwta KA oto Flow Navigator-

>Synthesis->Schematic kol KTOTLY KALK TTAVW 0TO Ovopa tou path (Path 2).

Schematic (2)

e a i ¥ o 4 = (C  5cCels 4UOFors 8 MNsts

low_level_IBUF_inst

buzzer OBUF _inst i 1

low_level > ! ||> o 10 buzzer_OBUF_inst
| [~ ©
IBUF IEl l/ : > buzzer
12 OBUF
above_25_ IBUF_inst
| I\ 0 LUT3
above_ 25 > I/
IBUF
above_30_IBUF_inst
| [~ O
above_ 30
x | > l\/

o]
[
T

Ewdva 22. To povondrt pe Tnv peyaAltepn kabuotépnon (kpiolpo povondrt).

Mo va 6o0pe emumA£ov MANPOGOPIES YLA TO LOVOTIATL KAVOULE SLMAG KALK 0TO OVOWA TOU OTO report
omnou epdaviletal To akoAoubo report:
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Epyaotnplo Aoyikng Zxediaonc (K02e)

Project Summary x | Device % | buzzer.vhd % | Schematic x | Schematic (2) »  Path 2 - timing_1 X 200
~ Summary

Name Path 2

Slack wns

Source [ above_30 (input port;

Destination 0 buzzer (output port

Path Group (none)
Path Type Max at Slow Process Corner

Requirement wons

Data P..Delay  5.229ns (logl 59.413%) route 1.599n
LogicLevels 3 (IBUF=1LUT3=10BUF=1
~ Data Path
Delay Type Incrins)  Path(ns) Location MNetlist Resource(s)
(ry0.000 0.000 [ above_30

net (fo=0) 0.000 0.000 /" above_30

[ above_30_IBUF_instil
IBUF (Prop ibuf | O (r)0.921 0.921 4 above_30_IBUF_instiO
net (fo=1, unplaced 0.800 1721 /" above_30_IBUF

[T buzzer_OBUF_inst_i_112
LUT3 (Pro..t2 12 O (ry0.124 1.845 {0 buzzer_OBUF_inst_i_1/0
net (fo=1, unplaced 0.800 2.645 7 buzzer_OBUF

[+ buzzer_OBUF_inst!
OBUF (Pr..buf | O) (r)2.584 5.229 41 buzzer_OBUF_instiQ
net (fo=0 0.000 5.229 /" buzzer

{1 buzzer

Ewkova 23. To povomartt pe Tnv peyalUtepn KabBuotépnon (kpioio povormart).

TNV evotnTa Summary mepAopUPAVEL APKETEG TIANPOOPIEG TTOU UTIAPYOUV KAl OTNV YPAUUA TOU
apxKoU report (Ewkova 21), aAAa €xel kat tnv evotnta Data Path, 6mou meplypddetol avaAuTtika n
Stadpopn tou povormatiol Ue MANRpn avaluon tng kabuotépnong os kaBe Pndlakd otolxelo 660 Kat
NG KaBUoTEPNGONG 0T CUPHLATA TIOU TAL EVWVOUV.
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Elcaywyn oto EpyaAeio Vivado

MNpooopoiwon Xpovikn peta tn ZUvOeon tou Ixediov BAua s

EkteAéote £va post synthesis timing simulation.

5-1-1. Ano 1o mapaBupo tou Flow Navigator emihé€te Simulation kat Uotepa Run Simulation > Run Post-
Synthesis Timing Simulation. O Vivado simulator Ba £ekwvrioeL xpnoomnowwvtag to Synthesized design
kat to buzzer_tb wgtop-level module.

Xpnowonowvtag tov Windows Explorer, enaAnBevote 6t o pakehog timing £xeL dnuoupynBel péoa
oto dakelo vivado_intro.sim > sim_1 > synth. O ¢dake)loc timing nepléxel Ta apyeia mou mapnxdbnoav
yla va ekteleotel to timing simulation.

5-1-2. Matrote oto kouuni Zoom Fit yla va Seite To mapdBupo e TI§ Kupatopopdés anod 0 €wg ta 160 ns.

5-1-3. Matnote 6¢€€i click ota 20 ns kat emhé€te Markers > Add Marker. Eval\aktikd, pmopeite va

npooBéoete éva marker pe click oto kouunt Add Marker ( o ).

5-1-4. Mapopola, matnote Skl click yla va mpooBéoete €éva marker yUpw ota 40 ns. MNapatnprote OTL av
TLATE TO TOVTiKL MAVW oTo marker €xete TN SUVATOTNTA VA TO LETOKLVIOETE.

Uniithed 1*

QO W a a XX « MM [ = o

Ewkdva 24. O kupatopopdEg tou timing simulation

Mapatnpnote tv Tpayuatikn kabuotépnon otnv alayn twv e€6dwv oe oxéon e To behavioral
simulation. H petaBoAr oto onua e€6dou (buzzer) yivetal pe kaBuotépnon mepinou 2,5 ns.

5-1-5. KhAeiote Tov simulator emmAéyovtag File > Close Simulation xwpig va owoeTe kK&TTolEG aAAAYEG.
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